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The User Interface 
 

e-Campaign is an exceptionally easy-to-use program, featuring an intuitive user 

interface. The main window contains a menu bar, a toolbar, and a ListView displaying 

all mailing jobs, and a Preview panel on the bottom. 

 

 
 

The Menu Bar  
 

The e-Campaign menus include: the File menu, the Mailing menu, the Reports menu, 

the Tools menu, and the Help menu 

 

File Menu  
 



 
 

 

New Mailing Job: Create a new mailing job 

Open: Import a mailing job file (*.bmj)  

Save Mailing Job As: Save a backup copy of the selected mailing job  

Print :  Print the selected mailing 

Print Preview: Generate a print preview of the selected mailing job 

Exit :   Exit e-Campaign 

 

Mailing Menu  
 

 
 

Send:  Send the selected mailing job 

Pause: Pause the delivery of a running mailing job. Paused jobs may be resumed by 

clicking the ñSendò menu again 

Schedule: Schedule a mailing to be sent at a specified time in the future 

Resend Failed Emails: Retry the failed addresses  

 

Edit : Launch the Message Composer to modify the selected mailing job 

Rename: Change the descriptive name of the selected mailing job 

Clone this Mailing Job: Make a new copy of the selected mailing jobs 

Remove: Delete the selected mailing jobs 

 

Reset Delivery Status: Clear the sending statistics, and mark it as a new mailing 

Send Test Email:  Send a test email to a single email address. This feature can be 

used to diagnose email sending problems. 

Mail Merge Preview: If  your message contains merge fields, you can preview the 

email merge results, and see how the final messages look like. 

 



 

Reports menu  
 

 
View Successful/Failed Addresses: Show the successful & failed email addresses 

Export Error Log : View the error log to see why emails fail 

Export Failed Addresses: Export a list of failed email addresses 

Export Successful Addresses: Export a list of successful email addresses 

Export Skipped Lines: If a line in the mailing list file doesnôt have a valid email 

address in the ñEmailò field, it will be ignored. You can view the ignored lines from 

this menu. 

 

 

Tools menu  
 

 
 

Email Accounts: Launch the ñEmail Account Managerò to configure Email Accounts 

(Profiles).  

Database Connections: Launch the ñDatabase Connection Managerò to configure 

database connections to access popular databases (including Microsoft Access, 

Microsoft Excel, SQL Server, etc.) 

Global Exclusion List: Exclude unwanted email addresses from all mailings on the 

fly 

Bounced/Unsubscribe Emails: Process bounced and unsubscribe emails 

Misc Utilities : the add-on utilities ñEmail Extractorò and ñListToolò 

 

Help menu  
 

 



 

Contents:  Display the Help file 

QuickStart Tutorial :  A brief tutorial to get you started using e-Campaign in a few 

minutes. 

Ordering Information : Display the purchase information on the website 

Enter License Key: Enter your purchased license keys to unlock e-Campaign, and 

turn it into full version. 

 

 

 

The Toolbar  
 

The Toolbars provide quick access to the menu options. 

 

 
 

  Create a new mailing job 
 

   Edit/Change the selected mailing job 

 

   Make a new copy of the selected mailing 

  Delete the selected mailing job(s) 
 

   Send the selected mailing job 

 

  Pause the delivery of a running mailing job. Paused jobs can be resumed by 

clicking the ñSendò button again 

 

  Schedule a mailing to be sent at a specified time in the future 
 

  Configure Email Accounts (profiles) 

 

  Configure database connections to access popular databases 

 

 



Quick-Start Tutorial 
 

e-Campaign is easy-to-use mailing list software. This tutorial is intended to quickly 

familiarize you with e-Campaign. You can get started using this software in 4 steps. 

 

Step 1: Setting up an Email Account 

 Click menu ñTools->Email Accountsò or the button  to create an Email 

Account to send emails.  

 

 
 

 

If you have SMTP email accounts configured in other email software (eg.Microsoft 

Outlook, Outlook Express, Mozilla Thunderbird, and Eudora), click the ñImportò 

button to import an Email Account. 

 

Otherwise, click the ñNewò button to create an email account from scratch.  

 



 
 

 

In the ñDelivery Methodò field, select SMTP, and enter the SMTP Server hostname, 

username, and password.  

 

Other delivery methods include ñDirect Sendingò, Microsoft Exchange Server, 

Microsoft IIS SMTP Pickup Folder. Refer to the ñConfiguring e-Campaign Sectionò 

for more detailed information about these delivery methods. 

 

 

Step 2: Creating a mailing list 

 

You can create/edit your mailing list file using any plain-text editor, such as Window 

Notepad. Save the mailing list file with a .txt file extension (eg. list1.txt) 

 

A simple (one-column) mailing list looks like this:  

 

Email 

mike@xxx.com 

tom@yyy.com 

kate@zzz.com 

 



A two-column mailing list file looks like this: 

 

Email, Name 

mike@xxx.com, Mike 

tom@yyy.com, Tom 

kate@zzz.com, Kate 

 

You can also use Microsoft Access or Microsoft Excel files as your mailing lists. 

Please refer to the ñCreating Mailing List & Working with Databasesò section for 

further details. 

 

 

Step 3: Creating a new mailing job 

1. Click menu ñFile->New Mailing Jobò or the button  to create a new 
mailing job. 

2. Specify a mailing list by clicking the óMailing Listò button or the ñMailing Listò 

menu. 

3. Select an Email Account from the ñAccountsò menu 

4. Enter the message body and subject. 

5. After you finish editing your email, press the  button on the Message Composer 

to save the changes. Click ñCloseò to exit the Message Composer and return to the 

main window. 

 

 
 

 

Step 4: Sending the email 



 

On the main window, select the newly-created mailing job. Then click button  to 

begin your emailing. 

 

This finishes the QuickStart tutorial.  

 

Configuring e-Campaign 
 

Setting  up an Email Account to send email  
 

As with other email software such as Microsoft Outlook and Outlook Express, you need to set up 

an email account before sending emails.  The Email Account will determine the Senderôs 

identification that appears on the messages, and the email delivery method to send the mailing. 

Click the Accounts icon  to launch the ñEmail Account Managerò. 

 

 

 
 

 

New:  Create a new account 

Modify :  Change an existing account 

Delete: Remove accounts 

Import : Click to import SMTP Email Accounts from other email software such as Microsoft 

Outlook, Outlook Express, Mozilla Thunderbird, and Eudora. 

 

 

Click the New or Import  button to add a new email account. 

 



 
 

In the Account Name field, enter a descriptive name for this email account. 

 

On the ñSender Informationò tab, enter the Senderôs Name, Email Address (which will show in 

the ñFromò field in recipientsô email software), and an optional Reply-To Address 

 

On the ñDelivery Settingsò tab, specify the Delivery Method for this email account.  You can use 

four methods to deliver your email messages: SMTP, ñDirect Sendingò (via built-in SMTP server), 

Microsoft Exchange Server, and Microsoft Internet Information Services (IIS) Pickup Folder. 

 

Email  Delivery  via an SMTP Email Account 
 

This delivery method sends email via an SMTP mail server, and is the most commonly used email 

delivery method. Enter the appropriate information into the following fields. If you donôt know what 

SMTP server to use, please consult your companyôs IT administrator or the ISP. 

 

SMTP Server  

 

Enter the hostname of the SMTP Server. If the server requires authentication, select the Requires 

Authentication checkbox, and enter the SMTP username and password. 

 



 

 
 

 

Optional Settings 

 

Num of Connections: To maximize email delivery speed, e-Campaign can send emails with 

multiple concurrent SMTP connections. Enter the number of concurrent connections to use for 

sending messages. Values range from 1 to 256, depending on the edition of e-Campaign you are 

using.   

 

Note: You should take into consideration the capacity of your SMTP server, and make sure it can 

handle that many of emails in a given period of time. If the SMTP server is not robust enough, using 

too many connections (ie, sending too fast) may get the server clogged up. Also, some SMTP servers 

may have a limit on the email delivery speed, or limit on the number of concurrent connections. We 

suggest you initially use 1 to 5 concurrent connections unless youôre quite sure that your SMTP 

server doesnôt impose any limit on the delivery speed. 

 

To control the email delivery speed, you can opt to momentarily stop sending messages after a 

certain number of messages have been sent and for a certain amount of time:   

  

 Pause every: Enter the number of messages sent after which e-Campaign will pause. Values range 

from 1 to 1000 



  

Seconds: Enter the amount of time (in seconds) to pause after the selected number of messages has 

been sent.  Leave the ñPause everyò and ñSecondsò boxes empty if no pause is needed. 

 

Email Delivery ÖÉÁ Ȱ$ÉÒÅÃÔ 3ÅÎÄÉÎÇȱ ɉȰ"ÕÉÌÔ-ÉÎ 3-40 3ÅÒÖÅÒȱɊ 
 

Direct Sending sends messages directly from the computer running e-Campaign. Enter the 

appropriate information into the following fields. 

 

 

 
 

 

Retry: Enter the number of times to retry sending a message. 

 

Route on Error: In case the message to a recipient failed to deliver via the built-in SMTP server (ie. 

ñDirect Sendingò), route it via an alternative SMTP or Exchange email account. This account (of 

type SMTP or Exchange Server) must already be set up.  

 

This selection can be used on its own or in conjunction with the Retry option. If the Retry option has 

been selected, the Route on Error option only activates after all retries have been exhausted.  

 



Num of Connection: Enter the number of connections to use for sending messages. Values range 

from 1 to 256, depending on the edition of e-Campaign you are using. 

 

  

 

Email Delivery via Microsoft II S SMTP Pickup Folder 
 

This option uses a third-party pickup service to deliver mail, or sends messages to a particular folder.  

 

 
 

 

 

Use local Microsoft IIS SMTP Pickup 

If you have Microsoft Internet Information Services (IIS) installed, this option will be enabled. Email 

will be sent to the IIS SMTP Pickup folder, which is C:\Inetpub\mailroot \Pickup by default 

 

Other Pickup directory  

Select the folder into which you want mail sent. 

 



Note: usually you may use the ñMicrosoft IIS SMTP Pickupò delivery method on a Microsoft 

Windows 2003/2008 server, or a Windows Vista/XP machine with IIS service installed. If no IIS is 

detected, the ñUse local Microsoft IIS SMTP Pickupò checkbox will be grayed out. 

 

e-Campaign will send the messages to the specified "Pickup" directory. Itôs the SMTP serverôs 

responsibility to pickup and transmit them to the destination mailboxes. 

 

Creating Mailing Lists & Working with Databases 
 

Mailing List Files  
 

e-Campaign supports plain-text mailing list files delimited by commas, tabs, 

semicolons, or vertical bars (|). 

 

You can create/edit your mailing list file using any plain-text editor, such as the 

Window Notepad. 

 

Rules for the mailing list format:  

 

1. All blank lines are ignored  

2. The first no-blank line should be the field names  

3. Each no-blank line is treated as a record  

4. Fields are separated with commas, tabs, or semicolons.  

5. Leading and trailing spaces of field values are trimmed. 
 

 

A simple (one-column) mailing list looks like this:  

 

Email 

mike@xxx.com 

tom@yyy.com 

kate@zzz.com 

 

 

You can have as many columns/fields as you wish. A three-column mailing list looks 

like this:  

 

FirstName, LastName, Email  

David, Smith, dsmith@xxx.co.uk  

Matt, White, matt@xyz.com  

Mary, Chou, marychou@xxx.com.tw  

Jan, Stotz, jstotz@xxx.de  

, , jacques@xxx.fr 

Yoshihiro, Mitsuyama, yoshihiro@yy.co.jp 

 

 

In this example, the mailing list has 3 fields (columns), namely "FirstName", 

"LastName", and "Email". Field values can be null (as in Line 6).  



 

 

Note: Field values should not contain the delimiter 

 

Connecting to Popular Databases  
 

e-Campaign can connect to popular databases (eg. Microsoft Access, Excel, SQL 

Server, etc.) via ADO/ODBC technology.  

 

A database connection will be treated as a mailing list in e-Campaign. You can create 

a database connection to provide access to fields in an external database such as 

Microsoft Access, Excel, and SQL Server. Use this connection to ensure that you are 

using the latest database records. 

 

 
 

To create a new database connection, click the New button to start. 

 



 
 

 

Connection Name: Descriptive name for this database connection 

 

Connection String: This defines which database e-Campaign connects to. If the 

database is a Microsoft Access or Excel file, simply click the ñUse Microsoft Access 

fileò or ñUse Microsoft Excel fileò button to create the connection string. 

 

For other types of databases, click the ñDatabase Connection Wizardò button to create 

a Connection String 

 

Define Mailing List Contents: After a connection string is defined, the ñUse Tableéò 

dropdown box will be populated with all available tables. Choose a table form the 

dropdown box you would like to use. Or, you can select the checkbox ñAdvanced 

data selection using SQLò, and enter SQL statements to define the records youôd like 

to use. 


